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Exploring the Web 
In this lesson you will learn how to: 

� Get around the Internet with your browser. 

� Connect to the Internet. 

� Print Web pages. 

� Save Web pages. 

Almost everyone has heard of the Internet, and most people know that www 

and dotcom have something to do with Web pages. But the Internet is much 

more than just Web page addresses. With the Internet, you can read up-to-the- 

minute news reports, reserve plane tickets, listen to music, send and receive 

electronic messages, get weather reports, shop, conduct research, and much 

more. 

What’s the difference between the Internet and the World Wide Web? The 

Internet is a network of computers, cables, routers, and other hardware and 

software that interconnect and run on a network. The World Wide Web consists 

of documents that are transmitted across the Internet’s hardware. The Web is 

made up of Web pages and Web sites. A Web page is a specially formatted 

document that can include text, graphics, hyperlinks, audio, animation, and 

video. A Web site is a collection of Web pages.  

Information comes in many forms on the Internet. To travel the Internet and 

read, view, or listen to the sights and sounds, you need a program called a 

browser. In this chapter, you’ll learn what Web pages are, how to use 

Microsoft’s browser, Microsoft Internet Explorer, and how to “surf” the 

Internet by following links between Web pages. 

What Is a Browser? 

A browser is a program that displays files that are in the HTML (Hypertext 

Markup Language) file format (in contrast to .doc files or .txt files that you 

view in your word processing program). The files can be located on the World 

Wide Web or on your own computer. Files in HTML format are often called 

Web pages because they are the “pages” you view as you move about the 

Internet. The browser also opens the next page you’ve selected when you click 

linked text on the Web page. A Web site is simply a collection of related Web 

pages. 

When you enter a Web address or click a hyperlink, you spark a series of 

events. First you tell your browser which document you want to view. Then the 

browser contacts the computer storing the document. After the computer is 

located, the browser downloads the document to your computer. In other 

words, the browser copies and transfers the Web page data from the computer 

storing the Web page to your computer. The browser then interprets the data 

and displays the Web page on your screen. 
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It is easy to create a Web page today. In addition to Web page creation 

programs such as Microsoft FrontPage, many other programs, including 

Microsoft Word, allow you to type information just as you would if you were 

writing a letter or document, add pictures or sounds, and then save the file in 

the HTML file format. The HTML file contains special codes that tell the 

browser how to display the words or images you have added to the page. 

You can create HTML files on your computer, but no one else can see them 

unless you put the Web page on a server. A server is any computer that has 

been set up so that others can use their computers to access the information 

stored on it. Your ISP (Internet service provider) maintains servers, providing 

you with a place to store Web pages that you want others to see. 

What, and Where, Exactly, Are We Browsing? 

When you connect to the Internet and open your browser, the browser window 

opens a Web page. Literally millions of Web pages are available on the World 

Wide Web. The content and nature of these pages range from children’s class 

joke pages to highly charged political commentary. Anyone can produce a Web 

page, and the diversity of the existing pages is testament to that. You can create 

one  too, if you’re game.  

The World Wide Web is actually a collection or Web of pages around the 

globe. The Web is truly global: When you start exploring, you might find 

yourself hopping between Web sites that are actually on servers located on 

several different continents. Your journey can take you around the world—not 

in 80 days, but in 80 seconds. 

Note  

A Web site that has several pages will also have a home page. A Web site 

home page acts as a table of contents for what’s available throughout the 

site. 

Web Addresses: What Do They Mean? 

A Web address is commonly referred to as a URL (which we pronounce as  

“U-R-L” but you might also hear pronounced as “earl.”) URL is short for 

Uniform Resource Locator. Every Web page has a unique address, so you can 

always find a favorite page and return to it easily at a later date. As peculiar as 

some URLs may appear, some standards are built into them to give you some 

sense of what you’ll encounter at the address. For example, Web site addresses 

can end with one of the following higher-level domain names. (A domain is 

roughly the equivalent of a category.) You are likely to encounter addresses 

with the domain names that appear in the following table. 
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Higher-Level 
Domain Name 

What It Signifies 

.com A commercial address 

.gov The federal government 

.int International 

.mil Military  

.net A network provider 

.org Some type of non-profit organization 

Some domain names indicate the country of origin (www.culture.fr). The 

following table offers a partial list. 

Country  
Domain Name 

Country of Origin 

.au Australia 

.ca Canada 

.fr France 

.cn China 

.il Israel 

.it Italy 

.jp Japan 

.uk United Kingdom 

.in India 

Getting Around the Internet with Your 
Browser 

The two most popular browsers currently available are Microsoft Internet 

Explorer and Netscape Navigator. Most computers allow you to connect easily 

using either browser, but we use Internet Explorer for our discussion here. 

There are several easy ways to open Internet Explorer. Here are two:  

■ Double-click the Internet Explorer icon on your desktop. 

■ Open the Start menu and select Internet Explorer from your list of 

programs. 

If you aren’t connected to the Internet when you open Internet Explorer, it will 

automatically dial up and connect you. When the dial-up/connecting process 

finishes, Internet Explorer appears, displaying your home page, which is your 

Internet home base. 
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Browser Window Anatomy 

The browser window, like other windows, has a title bar, a menu bar, and a 

toolbar. The title bar includes Minimize, Maximize, and Close buttons. The 

toolbar looks different than that of, say, Word because these two programs 

serve very different purposes. Like the Word toolbar, however, the Internet 

Explorer Standard toolbar gives you access to the most commonly used options 

in the program. The menu bar includes options unique to the functions of a 

browser. We describe the Standard toolbar a little later in this chapter. 

You can change your home page as you please. (We show you how later in this 

chapter.) The following illustration shows the home page, in this case, 

Microsoft.com. 

 

The browser window includes an Address Bar that displays the address of your 

current location. You can always type a new address into the Address field to 

check out a different Web site. We come back to addresses a little later in this 

chapter. 

Finally, the bottom of the window sports a status bar. When you go to a Web 

page or Web site, Internet Explorer might take a little time to access the page 

and display it for you. The status bar shows you where you are in the process. 

Tip  

When you visit a new page, make sure to get the whole story. If a scroll bar 

appears on the right side, it means that the page is longer than your screen 

can display. Scroll down to see what else the page provides. 
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A Web Page: What’s Hot and What’s Not   

When you visit a Web site, the site’s home page may be just the tip of the 

iceberg, so be sure to check out what hyperlinks are available to you. A 

hyperlink is an area or spot on a Web page that, when clicked, takes you to 

another Web page or a different section of the current Web page, as designated 

by the link. To find the hyperlinks on a Web page, move your mouse across the 

screen. When the cursor changes to a pointing hand, you have reached a link. 

Links can be found in text (typically, in a contrasting color), in pictures, even in 

empty screen space, so a little detective work usually pays off. 

Tip  

There might be times when you want to click a hyperlink, but you aren’t 

finished with the currently displayed page. In those instances, you can open 

the document referenced by the hyperlink in a separate window. That way, 

you can have two Internet Explorer windows open—one displaying the 

original document and another displaying the document associated with the 

hyperlink. To view a linked document in a separate browser window, press 

the Shift key while you click a hyperlink. 

Navigating Using The Standard Toolbar and the 
Keyboard  

With a few hyperlink clicks of your mouse, you manage to travel quite a 

distance into the World Wide Web. Traveling to destinations near and far is 

undeniably part of the fun of the Web, but it would become frustrating fast if 

the browser didn’t provide good navigation tools. Enter the Standard toolbar. 

Internet Explorer provides you with the tools you need to effectively explore 

the Web without becoming hopelessly lost. The toolbar is shown in the 

following illustration, and its buttons are described in the list that follows the 

illustration. You can also use keyboard shortcuts to navigate; those shortcuts 

are noted in parenthesis. 

Later versions of Internet Explorer might have buttons and features added or 

modified, so don’t panic if your toolbar has a button we don’t describe here. 

 

■ Back. The Back button returns you to the previous page. You can 

click the Back button repeatedly to backtrack to a page you visited 

previously. The Back button goes back only to sites that you visited 

during your current session. (To backtrack with the keyboard, press 

Backspace or Alt+Left Arrow.) 

■ Forward. The Forward button reverses the action of the Back 

button. If you go back too many pages, the Forward button enables 

you to move up to where you were. The Forward button goes 

forward only to sites that you visited during your current session. 

(To go forward with the keyboard, press Alt+Right Arrow.) 
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Tip  

You can click the drop-down arrows on the Back and Forward buttons to 

choose sites that you’ve already visited within a session. 

■ Stop. The Stop button stops a newly selected page from loading. 

When a page is taking a long time to load, or you see that it is not a 

page you want, clicking Stop will save you the time it would take to 

finish loading. (Press the Esc key to stop loading.) 

■ Refresh. The Refresh button retrieves the page again and reloads 

it. If you are interested in pages that include information that is 

constantly being updated—real-time stock quotes, for example—

the Refresh button updates the screen with the most current 

information available. (To refresh a page with the keyboard,  

press F5.) 

■ Home.  No matter where you find yourself, the Home button brings 

you back to your home page, that is, the page Internet Explorer first 

opens to. (Press Alt+Home.) 

■ Search. The Search button helps you find subject matter when you 

don’t know where to look. (Press Ctrl+E to open the Search bar.) 

■ Favorites. The Favorites button displays a list of Web sites to 

which you can go without typing the URL. (Press Ctrl+I to open the 

Favorites bar.) 

■ History. The History button shows you all the sites you have 

visited, listed by date. If you click one of the entries, you jump right 

to that site. (Press Ctrl+H to open the History bar.) 

■ Channels. The Channels button offers a diverse selection of Web 

sites, categorized by topic. 

■ Full Screen. The Full Screen button allows you to view a 

maximized Web page without the menu showing. (Press F11 to 

toggle between Full Screen and normal view.) 

■ Mail. The Mail button helps you manage your e-mail. 

■ Print. The Print button allows you to print the current Web page. 

(Press Ctrl+P.) 

■ Edit. The Edit button allows you to edit the currently displayed page 

in Notepad. 

■ Find. Although there isn’t a Find button on the Standard toolbar, 

you can press Ctrl+F to find text on a page. 
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Changing Your Home Page 

Each time you open Internet Explorer, you open to your home page. But where 

do you feel most at home? It’s easy to change your home page. Open the Tools 

menu and select Internet Options. The Internet Options dialog box appears, as 

shown in the following illustration. 

 

Put your preferred home page address in the Home Page Address field and 

click OK. That’s it. The next time you click the Home button or open Internet 

Explorer, your new home page will appear. 

Connecting to the Internet 

Before you can use anything on the Internet, you need to be able to connect to 

the Internet from your computer. If you’re part of a large company or 

organization, or you’re in a classroom, your computer might already have a 

direct connection to the Internet. However, if you work from home or if you 

work for an organization that doesn’t provide Internet service, you need to set 

up an account with an Internet Service Provider (ISP). An ISP is a company 

that has computers capable of connecting directly to the Internet. You contact 

your ISP and make your connection to the Internet through their computers.  
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Selecting an ISP 

Many different ISPs are available. Some are small, local companies; others are 

large multinational corporations. All good ISPs offer similar service─you do 

not have to use a large ISP to have multinational Internet connections. The 

difference in fees between the ISPs is usually based on the different types and 

quality of service they offer. Here’s what you should get from your ISP: 

■ Basic dial-up access to the Internet (access to the Web) 

■ Access from your home (either toll free or a paid local call)  

■ E-mail 

■ Usenet News (newsgroup access) 

■ Host services for your own Web page, should you decide to create 

one 

■ Technical support 

Service providers fall into two distinct classes: the big-name class and the little-

name class. Each class has advantages and disadvantages, and you should base 

your decision on your particular needs. 

Note  

The Internet is free. Your monthly ISP service charge is not a fee for using 

the Internet. Rather, it’s a fee for facilitating your connection to it. 

Dial-up vs. Broadband  

When selecting an ISP, you want to make sure that your ISP can handle your 

requirements. Just about every ISP can handle simple dialup modems. Dial-up 

modems are the most basic and slowest way to connect to the Internet. While 

dial-up connections work just fine for most Internet applications, anything that 

requires a lot of information transfer, such as live audio or video, large graphic 

animations, or interactive games, may not work properly on your computer. 

Other connection methods, such as DSL, cable modem, satellite, and ISDN, 

offer much faster Internet connections. These faster connections are usually 

called broadband connections. These allow for real-time delivery of audio  

and video, as well as great interactive applications. However, broadband 

connections are not available everywhere. Equipment limits can prevent 

broadband connections from being available to you. And even when broadband 

connections are available, most ISPs charge more for a broadband connection 

than for a simple dial-up connection.  

Not every ISP offers support for every type of connection. You need to make 

sure that the ISP you select supports the type of connections you use.  
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Fee or Free 

As mentioned, ISPs vary in their support and their costs. In fact, some ISPs 

provide free or reduced-cost Internet access. Most only offer free dial-up 

service; broadband usually costs a monthly fee. In exchange for the free 

service, the ISP displays advertisements on parts of your browser. The ISP 

might also record basic information about you and sell that information to 

advertisers. In addition, a free ISP might have some reduced services. For 

example, troubleshooting might be limited to online help files, with no one 

available to help you with any problems that occur with your system.  

If you already have access to the Internet, you can find a variety of free ISPs by 

using your browser and simply searching on “free Internet.” If you do not have 

access to the Internet, you can usually get a free trial period on a fee-based ISP 

(AOL, MSN, or Earthlink, for example). Trial periods are a great way to “test 

drive” an ISP to see if you want to do business with them in the future. 

ISPs that charge a larger fee usually offer more services, including support  

for faster connections, better user assistance in case of problems, fewer 

advertisements, and filters to reduce advertisements from other Web sites. You 

need to determine which ISP is most appropriate for your use based on your 

particular needs.   

Working Offline 

Sometimes you might not want to tie up your phone or data line by being 

connected to the Internet. However, the information you want is stored on a 

specific Web page. 

For example, you might have a listing of students involved in a school project 

(such as a play) and their parents’ contact information. For the convenience of 

the students and parents (ride sharing, planning, and so on) this information is 

shared among all the students in the play. So you create a listing of the students 

and their contact information and put it on a Web site, perhaps a secure site, for 

information about the play.  

If you are coordinating the play, you may need this information on a regular 

basis. Rather than dialing into the Internet and accessing this Web site, you 

could simply tell your Internet browser to make this information available to 

you offline. The browser then makes a copy of the current Web page and 

transfers that copy to your hard disk. The next time you need the information 

you can simply use your browser to access that page. When you are prompted 

to connect to the Internet, you have the option of telling the browser that you 

want to work offline. When you choose that option, the browser displays the 

copy of the Web page with the information you need.  

Remember, this Web page is just a copy of the version of the Web page from 

the last time you accessed that Web page. If the main Web page has been 

changed or the information on that page is changed, you won’t see the changes 

on your offline copy unless you access the online Web page again. 
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Printing Web Pages 

Internet Explorer lets you print Web pages in a variety of ways. You can print 

entire Web pages or selected items, You also can print frames and linked 

documents or you can print a table of links (these options aren’t covered in 

detail in this lesson, however). 

When you print an entire Web page, you can display the File menu and then 

click Print to display the Print dialog box (as shown in the following 

illustration). Or you can click the Print button on the toolbar. 

 

By default, Internet Explorer does not print Web page backgrounds. A Web 

page background is the color, texture, or picture that appears behind the text 

and graphics on a Web page. Printing Web page backgrounds can waste your 

time and the printer’s ink, as well as produce hard-to-read results. If you want 

to print a background, you must display the Tools menu, click Internet Options, 

click the Advanced tab, click the Print Background Colors And Images check 

box, and then click OK. 
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Important 

Your computer must be connected to a printer to complete the exercises in 

this section. In addition, you should verify that your printer is turned on. 

 

Beware of Copyrights 

Copyright protection on the Internet is a sticky issue. To be safe, assume 

that all material contained in an Internet document is copyrighted. That 

means that you can print material for your own private use, but you can’t 

reuse or redistribute the material without permission. If you want to reuse 

material, such as a photograph from the Lakewood Mountains Resort Web 

page, obtain permission from the Web site’s “Webmaster” or the contact 

person listed on the page. 

Occasionally, you’ll run across a site that offers free use of graphics or 

other material. For example, there are a number of sites that provide icons, 

background patterns, and custom bullets for use without permission. In 

those instances, feel free to copy and use the resources you find. 

Print a Web page 

In this exercise, you print the Microsoft.com home page. 

1 If necessary, start Internet Explorer. 

2 In the Address bar, type microsoft.com, and press Enter. 

3 The Microsoft.com home page appears. 

4 On the File menu, click Print. 

5 The Print dialog box appears. 

6 In the Page Range section, choose pages, and then click the OK 

button. 

7 The first page of the Microsoft.com home page is printed. 

Print selected items 

In this exercise, you print only the first paragraph of the Microsoft Press home 

page. 

1 In the Address bar, type microsoft.com/mspress, and press 

Enter. 

2 Select the first paragraph of text at the top of the page. 

3 On the File menu, click Print. 

4 The Print dialog box appears. 
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5 In the Print Range area, click the Selection option. 

6 Click OK. 

The selected text is printed. 

7 Click anywhere on the Web page to deselect the text. 

Saving Web Pages 

A Web page contains Hypertext Markup Language (HTML) formatting tags, 

graphics, and multimedia files. HTML formatting tags are used to format text, 

manipulate graphics, add background colors, and customize Web pages. 

Because a single Web page can consist of a number of embedded files (each 

graphic on a Web page is a separate file linked to the Web page’s text 

document), you can choose to save a Web page in four ways: 

■ Save a complete Web page. (This saves the HTML file and all 

additional files, such as images, embedded in the Web page.) 

■ Save an archive of a Web page. (This saves the entire Web page 

as a single, uneditable file.) 

■ Save only the HTML document. (This saves the HTML formatting 

tags, but does not save embedded files.) 

■ Save only the text appearing on the Web page. 

When you save a complete Web page, Internet Explorer automatically creates a 

folder with the same name as the saved file. This folder is also placed in the 

same location as the saved file. When you open the Web page, Internet 

Explorer opens, and all elements appear in the Web page, just as if you were 

viewing the page online. 

When you save a Web page as an archive file, you save the entire Web page 

without creating a separate folder to contain the Web page’s embedded 

elements. You can open the archive file to view the entire Web page on your 

hard disk drive, but you cannot change the Web page in any way, nor can you 

access separate components of the saved Web page such as graphics files. Be 

aware that while an archive file is a single file, it takes up more space on your 

computer than a Web page saved as a complete Web page. 

When you save an HTML file, you leave out the graphics and other embedded 

elements. You can read formatted text, but you won’t be able to view graphics 

because they’re not saved on your hard disk drive. 

Finally, when you save a Web page as a text file, you are saving only the text 

appearing on the page without any HTML tags. The saved text will not include 

any formatting, graphics, or other page elements. 
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Important 

If you are saving a Web page with frames, you must save the document as 

a complete Web page. The other save options do not work with framed 

Web pages. 

Save a complete Web page 

To save the Internet Explorer home page as a complete Web page, do the 

following: 

1 If necessary, start Internet Explorer. 

2 Type microsoft.com/windows/ie in the Address bar, and press 

Enter. 

3 On the File menu, click Save As. 

5 The Save Web Page dialog box appears. 

6 If necessary, click the Save In drop-down arrow, and click Desktop. 

7 In the File Name text box, select the current filename, and type 

Complete Web Page. 

8 The document you are saving will be named Complete Web Page. 

9 If necessary, click the Save As Type drop-down arrow, click Web 

Page, Complete (*.htm,*.html), and then click Save. 

A progress bar shows the progress of the operation as the page’s 

elements are saved. The document and its folder are saved to your 

desktop. 

Save only a Web page’s HTML file 

To save the Microsoft Word home page as an HTML file, do the following: 

1 Type microsoft.com/office/word in the Address bar, and press 

Enter. 

2 On the File menu, click Save As. 

3 The Save Web Page dialog box appears. 

4 If necessary, click the Save In drop-down arrow, and click Desktop. 

5 In the File Name text box, type HTML Only. 

6 Click the Save As Type drop-down arrow, click Web Page, HTML 

Only (*.htm,*.html), and then click Save. 

A progress bar shows the progress of the operation as the page’s 

elements are saved. The document is saved on your desktop as an 

HTML file. 
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Save a Web page as a text file 

To save the Microsoft Excel home page as a text file, do the following:. 

1 Type microsoft.com/office/excel in the Address bar, and press 

Enter. 

2 On the File menu, click Save As. 

3 The Save Web Page dialog box appears. 

4 If necessary, click the Save In drop-down arrow, and click Desktop. 

5 In the File Name text box, type Text File. 

6 Click the Save As Type drop-down arrow, click Text File (*.txt), and 

then click Save. 

A progress bar shows the progress of the operation as the page’s 

elements are saved. The document is saved as a text file, without 

HTML formatting. 

7 Click the Close button at the top-right corner of the Internet 

Explorer window, and minimize any open windows to display your 

desktop. 

You can click hyperlinks on Web pages saved as complete or archived to 

access the linked Web pages on the Internet. 

View saved Web pages 

To view saved Web pages, do the following:. 

Important 

The steps in this section assume that you are using the Web pages in the 

Part VI, Lesson01 folder in the Computer Fundamentals Practice folder on 

your hard drive. 

1 Click the Start button. 

2 Click the My Computer icon. 

3 Double-click the Local Disk (C:) icon. 

4 Double-click the Unlimited Potential folder on your hard disk. 

5 Double-click the Computer Fundamentals Practice folder.  

6 Double-click the Part VI folder, then the Lesson01 folder. 

You should see the following files displayed in that folder: 
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7 Double-click the Complete Web Page icon. 

A complete copy of the saved Web page appears in Internet 

Explorer with all graphics and other components embedded in the 

Web page. The local address is displayed in the Address bar. 

8 Double-click the HTML Only icon  

A modified version of the saved Web page appears in Internet 

Explorer. The graphics are not displayed, because they are not 

saved within the file. 

9 Double-click the Text File icon. 

A text file is displayed without any formatting. The text file appears 

in Notepad or another text editor instead of appearing in the 

Internet Explorer window. 

10 Click the Close button at the top-right corner of the text editor. 

Lesson Wrap-Up 

This lesson introduced you to Web browsers and Web addresses. You learned 

how to connect to the Internet and “surf” the Web.  Finally, you learned to print 

and save Web pages. 

If you are continuing to the next lesson: 

• Click the Close button in the top right corner of the Internet Explorer 

screen to close your browser. 

If you are not continuing to other lessons: 

• Click the Close button in the top right corner of the Internet Explorer 

screen to close your browser. 

Quick Quiz 

1 What is a browser? 

2 What is a URL? 

3 How do hyperlinks work? 

4 What are the different ways to connect your computer to the 

Internet? 

5 What are the limits to what you can use from the Internet without 

having to ask permission from a site’s Webmaster? 

6 Name the three ways to save Web pages. 
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Putting It All Together 

Exercise 1:  Open the Start menu and select Internet Explorer from your 

list of programs. Type microsoft.com in the Address field and press Enter 

to go to the Microsoft Web site. Spend a few minutes clicking on hyperlinks 

and explore the site. 

Exercise 2:  Set a new default Internet Explorer home page. Start Internet 

Explorer, open the Tools menu, and click Internet Options. Type a different 

URL in the Address box, and then click the OK button. 

Exercise 3: Preview and print Web pages. Start Internet Explorer, type the 

address of the URL you want to print in the Address bar, and press Enter. 

On the File menu, click Print Preview. Click the Print button on the toolbar. 

Finally, make any desired changes in this dialog box and then click the Print 

button. 

Exercise 4: Save a Web page graphic. Start Internet Explorer, type the 

address of the URL you want to visit, and press Enter. Right-click any 

graphic on the page, and on the short menu, click Save Picture As. Finally, 

browse to the location where you want to save this picture, and then click 

the Save button. 


